
Welcome to the GC75 Manager  

The GC75 Manager controls the GC75 PC Card and provides the following functions:  

Startup and shutdown the GC75 PC Card's radio transmitter  

Definition of network connections over CSD/HSCSD and GPRS  

Connect to and disconnect from the internet or corporate network  

GSM settings such as network service provider, call diversion and call barring  

Send and receive SMS Text Messages  

Management of the SIM Phone Book  

When the GC75 Manager is activated, the GC75 Manager icon is shown in the taskbar at the bottom right 
corner of your computer screen.  

See also: 

GC75 Manager Icon 

Dial-Up Networking Icon 

PC Card Icon 

  

GC75 Manager Icon  

The GC75 Manager icon is shown in the taskbar when the GC75 Manager is running. In the following 
example, the GC75 Manager icon appears to the left of the time-of-day clock:  
 

   

The GC75 Manager icon will indicate if a GC75 PC card is inserted as well as the GSM/GPRS service status 
and connection state.  

The GC75 Manager icon shows the following states:  
 

  

Right click on the GC75 Manager icon to view the GC75 Manager Menu . To close the GC75 Manager, select 

 
The radio transmitter is in the power off (disabled) state. 

 
The radio transmitter is on, but there is no GSM or GPRS service available. 

 
The GC75 has GSM service and indicates a signal strength of 3 out of 5 bars. CSD/HSCSD, SMS 
and FAX may be used, provided these are supported by the subscription. GPRS is not available. 

 
The GC75 has GSM and GPRS service. 
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Exit from the menu list.  

The application can be restarted by going to the Windows Start menu and selecting Programs\Sony 
Ericsson\GC75 Manager.  

See also: 

GC75 Manager Menu 

  

GC75 Manager Menu  

Right clicking the GC75 Manager icon in the taskbar activates a menu with the following options:  

Open GC75 Manager 
Open or restore the GC75 Manager window. This is useful in case you have minimized the window or 
have selected the Hide to Tray option.  
  

Turn Radio On/Off 
Turn the radio transmitter in your GC75 PC Card On or Off. Radio On/Off status is shown by the GC75 
Manager icon.  
  

Connect to 
Connect to the most recently used connection.  
  

Help  
Display help information.  
  

About  
Display information about the GC75 Manager.  
  

Hide to Tray  
"Hide" the GC75 Manager window in the system tray. The taskbar will no longer show a GC75 Manager 
button. You can use the Open GC75 Manager option to restore the GC75 Manager window.  
  

Exit  
Exit the GC75 Manager. The GC75 Manager can be restarted by going to the Windows Start menu, 
selecting Run... and selecting Programs\Sony Ericsson\GC75 Manager.  
  

See also: 

GC75 Manager Icon 

  

Dial-Up Networking Icon  
 

 
The Dial-Up Network icon is displayed in the taskbar to indicate that a remote network connection is 
established and usable. A connection is established by selecting a dial-up connection from the list 
in the GC75 Manager application and then clicking the Connect button 
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A Dial-Up Networking connection can be established only in Radio On mode. The Connect button is disabled 
(greyed) in Radio Off mode.  

PC Card Icon  
 

  

The PC Card icon is used as part of the procedure to remove the GC75 PC Card.  

To remove the GC75 PC card:  

1. Right-click on GC75 Manager icon and select Exit  

2. Left-click on the PC card icon and select Stop GC75 or right-click on the PC Card Icon and select 
Unplug or Eject Hardware and Stop the card.  

 
The PC Card icon is displayed in the taskbar area when the GC75 PC Card is properly inserted into 
the PC card slot. 

Phone Locked Dialog  

Phone Lock is a means by which you can protect your GC75 PC Card against theft or unauthorized use. 
When enabled, the GC75 PC Card will not operate until the Phone Lock code has been entered. Phone lock is 
additional to the PIN, which protects the SIM.  

If your phone is locked and you are required to enter the phone's lock code, a Phone Locked dialog is 
displayed. Enter the code and select OK.  

Only numerical digits are allowed for Phone Lock.  

Note: For security reasons, the code digits are always shown as asterisks in the entry field.  

SIM Card Locked Dialog  

If your SIM Card is locked and you are required to enter the PIN code, a SIM Card Locked dialog box is 
displayed. Enter your PIN code and select OK.  

Only numerical digits are allowed for SIM Lock.  

Note: For security reasons, the PIN code digits are always shown as asterisks in the entry field.  

If the PIN code that you have typed is incorrect, the dialog box re-appears and you have two remaining 
attempts to enter the correct code. The SIM card will be blocked after three failed attempts.  

If you enter your PIN incorrectly three times in a row, the SIM card is blocked and you need a PUK code to 
unblock the SIM card.  

For further information, contact your network operator.  

See also: 

SIM Card is Blocked 
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SIM Card is Blocked  

After three failed attempts to enter the SIM PIN code, the SIM will be blocked and the SIM Card Blocked 
Dialog will be displayed.  

To unblock the SIM, you must enter the PUK code supplied by your mobile operator. Enter the PUK code in 
the SIM Lock dialog, and then a new PIN code, which you should confirm in same dialog box. 

Change GC75 Manager Settings  

To change GC75 Manager settings:  

1. From the File menu, select Preferences...  
 

2. On the Radio Power tab, select appropriate radio buttons to set Radio Settings.  
 

3. On the Text Messages tab, enable or disable to receive cell broadcast SMS messages.  
 

4. On the Notifications tab, select the appropriate check boxes.  
 

Show splash screen at GC75 Manager startup - if you want to see information about which 
version you use and copyright information every time you start the GC75 Manager .  
 
Confirm that the GC75 Manager has terminated .  
 

5. On the Miscellaneous tab, select the appropriate check boxes.  
 

Hide to Tray When Minimized.  
 
Show Menu Item for Modem Software Update.  
 

6. Click OK to save the changes.  

Radio Settings  

You can change Radio settings by selecting File | Settings, then clicking on the Radio Power tab:  

On GC75 Manager startup and standby-resume:  

Turn Radio On 
When the GC75 Manager is running in radio on mode it is registered to the mobile network and will 
transmit signals to the network even if no Dial-Up Networking connection is in progress. Three options 
are available in areas where radio devices are forbidden (e.g. airplanes):  
  

Turn Radio Off 
Radio Off indicates that the wireless network is currently disconnected. During theRadio Off state, all 
communication between the GC75 PC Card and the network is disabled, but you may still perform non-
communication related activities on the GC75 PC Card. The status of the GC75 Manager icon will 
confirm that the radio transmitter is Off.  
  

Ask Me 
If the Ask option is selected in the Radio Settings menu, a dialog box is displayed allowing you to 
decide whether the radio transmitter should be turned On or Off before activating the GC75 PC Card. 
This option is especially useful if you travel in areas where equipment with radio transmitters is 
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prohibited, such as aircraft, hospitals and blasting areas.  
  

On GC75 Manager Shutdown:  

Turn Radio Off 
Turn radio off before GC75 Manager exists.  
  

Reset Card 
Restart the card, and reset to default radio settings.  
  

Note: the Ask option is selected the first time GC75 Manager is started after installation. The default radio 
setting is to turn the radio off when the application exits.  

Navigating Help  

If you encounter problems and need help, you can access this help file from within the GC75 Manager by 
selecting Help Topics from the Help menu.  

From the Contents tab, you can select a topic from a structured list. To find the topic you want:  
 

1. Click the plus sign next to the topic folder to see more detailed information.  
 

2. Click on the topic you want to display.  
 

From the Index tab, you can select from an alphabetized list of topics, or type in a related word and 
select from the topics shown.  
 
From the Search tab, you can search for an exact word or phrase.  
 
From the Favorites tab, you can keep a list of your favorite topics for quick reference.  
 

Note: To provide further assistance, help topics may also provide links to other help topics covering similar 
subjects under a See Also heading.  
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Status Monitor  

The Status Monitor is the default view presented when the GC75 Manager starts. It can be re-displayed at any 
time via the large toolbar button on the left or by selecting Status from the View menu.  

  

 

The Status Monitor shows graphical icons that represent:  

Signal strength  
 
GPRS service status  
 
Unread SMS Text Message status (with SIM Full indication)  
 
Connection status  
 
Voice Mail Waiting  
 

When first started, 'Searching…' indicates that the GC75 is searching for the mobile network. Once found, the 
network name is displayed.  

The current Network Operator name is displayed (or "Searching..." if unregistered, or "Radio disabled")  

The status area also shows connection progress messages when a data session is in the process of being 
established.  

The right side of the status view screen displays the Connection Manager. When a connection is established, 
the connection statistics (duration, bytes transmitted, bytes received) is also displayed and updated at regular 
intervals.  

Note: Statistics display is not supported on Window 98SE or ME platforms.  

Connection Manager  

The Connection Manager is part of the Status View window. The Connection Manager provides a means to 
connect, cancel, or disconnect a GPRS or CSD/HSCSD session.  
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A drop-down selection box displays the dialup networking connections that have been created using the 
Connection Wizard. A button allows the user to connect, cancel, or disconnect an existing session.  

It is possible for the user to bypass the built-in GC75 Connection Manager and launch or terminate dial-up 
networking sessions directly from the Windows Network Connections folder. In the case of launching new 
connections, the additional connection-specific initialization strings are not sent to the modem and the 
connection is attempted with whatever settings or power-up defaults may have been left in the modem from a 
previous session.  
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Telephony Settings  

Telephony Settings provides a means to view or modify settings that are saved in the GC75 PC Card or SIM. 
This view can be selected via the large toolbar button or via the View | Telephony Settings command.  

Telephony view is divided into a number of groups. The left group provides a tree-like view to select the sub-
view. The right groups displays the data for the selected sub view.  

  

 

In Telephony Settings you are able to query or modify:  

Phone Numbers  
 

My numbers  
 
SMS Service Center  
 

Locks  
 

Phone Lock  
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SIM Lock  
 

Networks  
 

Current network  
 
Preferred networks  
 
Frequency band  
 

Divert Calls  
 

Divert all incoming calls  
 
Divert voice calls  
 
Divert FAX calls  
 
Divert data calls  
 

Restrict Calls  
 

Restrict voice calls  
 
Restrict FAX calls  
 
Restrict data calls  
 

Phone Numbers  

This section covers the following topics:  

My Numbers  
 
SMS Service Center  
 

My Numbers  

This function makes it possible for you to store all of your numbers in one place. In this way, you can easily 
find the numbers when someone asks you for them.  

GSM subscriptions can have three types of telephone numbers assigned: Voice, Data and FAX.  

Voice 
These are the phone numbers you use for normal voice calls. If you only have one phone number, then 
you should enter this in the Line 1 box. You may have Alternate Line Service, e.g.. one line for your 
business calls and one for your private calls. In this case, enter your second phone number in the Line 
2 box.  
  

Data 
The phone number used to make a data call to the GC75 (Mobile Terminated).  
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FAX 
The phone number used to send a FAX to the GC75.  
  

Click Apply when you have finished changing the settings, to transfer your settings to your GC75 PC Card. 
This may take a few seconds.  

Note: if you change these numbers to some incorrect phone numbers and you forget the original numbers, you 
may need to call your service provider to get the correct numbers back for your SIM.  

SMS Service Center  

When you send a text message, it is first sent to your network operator's service center, which then forwards it 
to the correct recipient. The SMS Service Center is identified by a telephone number.  

To set or change the SMS Service Center number:  

1. Enter the phone number of your operator's service center in the Number text box.  
 

2. Click Apply to transfer the setting to your GC75 PC Card.  
 

Locks  

This section covers the following topics:  

Phone L ock  
 
SIM Lock  
 
PIN  
 
Changing the Phone Lock Code  
 

Phone Lock  

The phone lock protects your GC75 PC Card against unauthorized use if it is stolen and used with another 
SIM card. The phone lock is not activated when you buy the GC75 PC Card. You can change the default 
security code 0000 to any four- to eight-digit personalized code. 

The phone lock has three options: On, Off and Auto:  

On - If you choose this alternative, you briefly see the message Phone locked, each time you turn on 
the GC75 PC Card . The message is followed by the prompt Enter lock code. You then have to enter 
your code followed by YES to use the GC75 PC Card .  
 
Off - The GC75 PC Card is no longer locked.  
 
Auto - The message Phone locked and the prompt Enter lock code do not appear until a different 
SIM card is inserted into the GC75 PC Card. After the security code has been entered correctly, the 
GC75 PC Card can be used with the new SIM card. You are not asked to enter the security code until 
the original SIM card or a different SIM card is inserted  
 

When you are satisfied with the settings, click Apply.  
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See also: 

Changing the Phone Lock Code 

  

SIM Lock  

Some SIM cards are protected with a PIN at the time of purchase. If the SIM PIN is activated, you have to 
enter the PIN every time you turn on your GC75 PC Card. If you enter your PIN incorrectly three times in a 
row, the SIM card is blocked and you need a PUK code to unblock the SIM card. For further information, 
contact your network operator.  

You should be careful with your PIN, since it is your protection against unauthorized use of your GC75 PC 
Card and subscription.  

Activating the SIM card lock:  

Choose On. You must enter the PIN code to unlock the SIM.  
 

Canceling the SIM PIN:  

Choose Off.  
 

Note: You have to use your PIN code to turn the SIM card lock off.  

When you are satisfied with the settings, click Apply.  

Changing your PIN code:  

1. Select Change PIN Code.  
 

2. Enter your old PIN code, followed by your new four- to eight-digit PIN code. Confirm the new code by 
entering it again.  
 

3. Click OK.  
 

If you enter your PIN incorrectly three times in a row, the SIM card is blocked and you need your PUK code to 
unblock it. Contact your network operator for further information.  

Note: The SIM PIN only protects your subscription -- not your GC75 PC Card itself -- from unauthorized use.  

Note: You should be careful with your PIN, since it is your protection against unauthorized use of your GC75 
PC Card and subscription.  

Changing the Phone Lock Code  

The phone lock protects the GC75 PC Card against unauthorized use if it is stolen and used with another SIM 
card. It is not activated when you buy the GC75 PC Card. You can change the default security code 0000 to 
any four- to eight-digit personalized code.  

To change the phone lock code:  

1. Click Change phone code.  
 

2. In the dialog box, enter your old security code, followed by your new security code. Then confirm the 
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new code by entering it again.  
 

3. Click OK.  
 

Networks  

This section covers the following topics:  

Current Network  
 
Preferred Network  
 
Frequency Band  
 

Current Network  

You can select which network you want to use by going to Networks and then choosing Current Network.  

When the user opens this page, the GC75 manager automatically retrieves and displays the currently 
available networks. . 
 
To select a network:  

1. Highlight the network that you want to use.  
 

2. Click Apply.  
 

NOTE: Ability to use the network in this section relates to CSD data calls only. HSCSD is not available in 
every GSM network and requires a supplementary roaming agreement between mobile operators for visiting 
users to use HSCSD. Check with your home operator regarding the country or region in which you want to 
roam. GPRS is commonly available in GSM networks, but fewer roaming agreements are in place. You may 
therefore need to explicitly select one of the available networks in order to use GPRS when abroad. Check 
with your home operator to find out which networks are GPRS roaming partners in the country or region in 
which you want to roam.  

See also: 

Preferred Network 

  

Preferred Network  

A list of preferred networks is stored on the SIM card. This is typically set up by your mobile operator. 
Preferred roaming partners are placed in the list so that you have the greatest range of available services 
while roaming. When the home network is not available, the GC75 will check the available networks against 
the preferred network list and select the one placed highest. Automatic network selection must be enabled. 
You may change the networks in the preferred list.  

If you want to add a new network:  

1. Click Add and a new dialog box listing all the networks known to the GC75 PC Card appears on the 
screen.  
 

2. Select the network that you want to add and click OK.  
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3. Click Apply to transfer the setting to your SIM Card .  

 
If you want to delete a network from the list:  

1. Select the network that you want to delete.  
 

2. Click Remove.  
 

3. Click Apply to transfer the setting to your SIM Card .  
 

If you want to re-arrange the order of the networks listed:  

1. Select the network that you want to move.  
 

2. Click the Move Up or Move Down button to reorder the list.  
 

3. Click Apply to transfer the setting to your SIM Card .  
 

Note: If the list of preferred networks is full, Add is disabled (gray).  

See also: 

Current Network 

  

Frequency Band  

GSM operates in a number of different frequency bands. 900 and 1800MHz are used in Europe, Asia, 
Australia, Asia and Africa, while the 1900MHz band is used in North and South America.  

By default your GC75 will operate in 'tri-band' mode and automatically find available networks in any of these 
frequency bands. It is not recommended to change this setting.  

To change the frequency band setting:  

1. Select the button to the left of the desired band.  
 

2. Click Apply to transfer the setting to your GC75 PC Card  
 

Diverting Calls  

This section covers the following topics:  

Diverting All Incoming Calls  
 
Diverting Voice Calls  
 
Diverting Data Calls  
 
Diverting FAX Calls  
 

Diverting All Incoming Calls  
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If you want to make certain that all your incoming voice calls are taken care of when you cannot answer them, 
you can use the Call forward service to forward them to another phone number.  

Note: The Call forward service may not be available on all networks. Also, if you are using the Call restrict 
function, this may influence Call forward.  

Selecting a call forward setting:  

1. To get your current call forward settings from the network, click Retrieve.  
 

2. Make your changes and select the situation in which you want to forward your incoming calls. You can 
select from four different diversion options:  
 

Always - This forwards all incoming calls to the phone number that you have entered in the text 
box.  
 
When busy.  
 
No reply.  
 
Not reachable - for example, when your laptop is turned off or the GC75 radio transmitter has 
been set to Off.  
 

3. Enter the destination number in the text box next to the forward option you have chosen. Or click 
Phone Book, choose a phone number from your Phone Book, and then click OK.  
 

4. Click Apply when you have finished changing the settings, to transfer your settings to your GC75 PC 
Card. This may take a few seconds.  
 

Your call forward setting has now been stored on the network.  

See also: 

Diverting Voice Calls 

Diverting Data Calls 

Diverting FAX Calls 

  

Diverting Voice Calls  

If you want to make certain that your voice calls are taken care of when you cannot answer them, you can use 
the Call forward service to forward them to another phone number.  

Note: The Call forward service may not be available on all networks. Also, if you are using the Call restrict 
function, this may influence Call forward.  

Note: This might happen if sharing the same SIM card for a mobile phone (voice) and Data in the GC75 PC 
Card.  

Selecting a call forward setting:  

1. To get your current call forward settings from the network, click Retrieve.  
 

2. Make your changes and select the situation in which you want to forward your incoming calls. You can 
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select from four different diversion options:  
 

Always - This forwards all incoming calls to the phone number that you have entered in the text 
box.  
 
When busy.  
 
No reply.  
 
Not reachable - for example, when your laptop is turned off or the GC75 radio transmitter has 
been set to Off.  
 

3. Enter the destination number in the text box next to the forward option you have chosen. Or click 
Phone Book, choose a phone number from your Phone Book, and then click OK.  
 

4. Click Apply> when you have finished changing the settings, to transfer your settings to your GC75 PC 
Card. This may take a few seconds.  
 

Your call forward setting has now been stored on the network.  

See also: 

Diverting All Incoming Calls 

Diverting Data Calls 

Diverting FAX Calls 

  

Diverting Data Calls  

If you want to make certain that your data calls are taken care of when you cannot answer them, you can use 
the Call forward service to forward them to another phone number.  

Note: The Call forward service may not be available on all networks. Also, if you are using the Call restrict 
function, this may influence Call forward.  

Selecting a call forward setting:  

1. To get your current call forward settings from the network, click Retrieve.  
 

2. Make your changes and select the situation in which you want to forward your incoming calls. You can 
select the following option:  
 

Always - This forwards all incoming calls to the phone number that you have entered in the text 
box.  
 

3. Enter the destination number in the text box next to the forward option you have chosen or click Phone 
Book and choose a phone number from your phone book then click OK.  
 

4. Click Apply when you have finished changing the settings, to transfer your settings to your GC75 PC 
Card. This may take a few seconds.  
 

Your call forward setting has now been stored on the network.  

See also: 
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Diverting All Incoming Calls 

Diverting Voice Calls 

Diverting FAX Calls 

  

Diverting FAX Calls  

If you want to make certain that your FAX calls are taken care of when you cannot answer them, you can use 
the Call forward service to forward them to another phone number.  

Note: The Call forward service may not be available on all networks. Also, if you are using the Call restrict 
function, this may influence Call forward.  

Note: If the user don't expect fax it should be turned off.  

Selecting a call forward setting:  

1. To get your current call forward settings from the network, click Retrieve.  
 

2. Make your changes and select the situation in which you want to forward your incoming calls. You can 
select the following option:  
 

Always - This forwards all incoming calls to the phone number that you have entered in the text 
box.  
 

3. Enter the destination number in the text box next to the forward option you have chosenor click (Phone 
book) and choose a phone number from your phone book then click OK. 
 

4. Click Apply when you have finished changing the settings, to transfer your settings to your GC75 PC 
Card. This may take a few seconds.  
 

Your call forward setting has now been stored on the network.  

See also: 

Diverting All Incoming Calls 

Diverting Voice Calls 

Diverting Data Calls 

  

Restricting Calls  

This section covers the following topics:  

Restricting Voice Calls  
 
Restricting Data Calls  
 
Restricting FAX Calls  
 

Page 9 of 12Telephony Settings

4/11/2003file://C:\temp\~hh29E6.htm



Restrict Calls Password  
 

Restricting Voice Calls  

Restricting a certain type of call means that this type of call cannot be made to or from your phone. You can 
restrict different types of outgoing and incoming calls.  

The following call types can be restricted:  

All outgoing calls.  
 
All outgoing international calls.  
 
All outgoing international calls except to your own country.  
 
All incoming calls.  
 
All incoming calls when you are abroad (when roaming).  
 

If you do not want anybody else to change the call restrictions that you have made, you can protect your call 
restrictions with a password that comes with your subscription is needed in order to turn a call restriction on or 
off. Contact your network operator for further information.  

Changing the call restrict status for voice calls:  

1. To get your current call restrict settings from the network, click Retrieve  
 

2. Check the boxes next to the call types that you want to restrict.  
 

3. When you have finished, click Apply.  
 

4. In the dialog box, enter your restriction password and click OK.  
 

Your call restrict settings have now been changed and stored on the network.  

See also: 

Restricting Data Calls 

Restricting FAX Calls 

Restrict Calls Password 

  

Restricting Data Calls  

Restricting a certain type of call means that this type of call cannot be made to or from your phone. You can 
restrict different types of outgoing and incoming calls.  

The following call types can be restricted:  

All outgoing calls.  
 
All outgoing international calls.  
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All outgoing international calls except to your own country.  
 
All incoming calls.  
 
All incoming calls when you are abroad (when roaming).  
 

If you do not want anybody else to change the call restrictions that you have made, you can protect your call 
restrictions with a password that comes with your subscription is needed in order to turn a call restriction on or 
off. Contact your network operator for further information.  

Changing the call restrict status for data calls:  

1. To get your current call restrict settings from the network, click Retrieve  
 

2. Check the boxes next to the call types that you want to restrict.  
 

3. When you have finished, click Apply.  
 

4. In the dialog box, enter your restriction password and click OK.  
 

Your call restrict settings have now been changed and stored on the network.  

See also: 

Restricting Voice Calls 

Restricting FAX Calls 

Restrict Calls Password 

  

Restricting FAX Calls  

Restricting a certain type of call means that this type of call cannot be made to or from your phone. You can 
restrict different types of outgoing and incoming calls.  

The following call types can be restricted:  

All outgoing calls.  
 
All outgoing international calls.  
 
All outgoing international calls except to your own country.  
 
All incoming calls.  
 
All incoming calls when you are abroad (when roaming).  
 

If you do not want anybody else to change the call restrictions that you have made, you can protect your call 
restrictions with a password that comes with your subscription is needed in order to turn a call restriction on or 
off. Contact your network operator for further information.  

Changing the call restrict status for FAX calls:  

1. To get your current call restrict settings from the network, click Retrieve.  
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2. Check the boxes next to the call types that you want to restrict.  

 
3. When you have finished, click Apply.  

 
4. In the dialog box, enter your restriction password and click OK.  

 
Your call restrict settings have now been changed and stored on the network.  

See also: 

Restricting Voice Calls 

Restricting Data Calls 

Restrict Calls Password 

  

Restrict Calls Password  

To make sure that someone else does not change a call restriction, you need a password in order to turn a 
call restriction on or off. This password comes with your subscription, if the restrict calls service is included in 
the subscription.  

You can easily change the password as often as you like by following these steps:  

1. Click Change restrict password.  
 

2. Enter your current password in the first box.  
 

3. Enter your new password in the second box and confirm this new password in the third box.  
 

4. Click OK.  
 

The message Please wait appears, followed by a message confirming that the password has been changed.  
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Phone Book  

When you have entered phone numbers into the SIM Phone Book it may become disorganized with names in 
upper case and duplicates. The Phone Book feature helps you organize the phone book in an easy way. In the 
Phone Book view you are able to:  

Add a Number 

Edit a Number 

Delete a Number 

Arrange the Numbers 

Import Phone Book Lists 

Export Phone Book Lists 

Add a Number  

To add a number to a Phone Book:  

1. In the List view, click on either the SIM Phone Book or Saved Phone Book icon.  
 

2. Select Add New from the Phone Book menu.  
 

3. In the pop-up dialog box, enter the name and number in their respective text boxes.  
 

4. Click OK.  
 

Note: The length of a Phone Book name may be limited by the SIM card. To copy a name from PC memory to 
the SIM card it may be necessary to shorten it first.  

See also: 

Edit a number 

Delete a number 

Arrange the numbers 

Import Phone Book Lists 

Export Phone Book Lists 

  

Edit a Number  

After you have added or received a number, you can edit the information.  

Editing information for a number:  

1. Click on either the SIM Phonebook or Saved Phonebook icon.  
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2. Select the number you want to edit and then select Modify from the Phonebook menu.  
 

3. The information for the number can now be seen in a dialog box.  
 

4. Edit the information.  
 

5. Click Save to save your changes.  
 

See also: 

Add a number 

Delete a number 

Arrange the numbers 

Import Phone Book Lists 

Export Phone Book Lists 

  

Delete a Number  

Deleting a number:  

1. Click on either the SIM Phonebook or Saved Phonebook icon.  
 

2. Select the number that you want to delete.  
 

3. From the Edit menu, select Delete. If a message box appears confirm by clicking OK.  
 

Note: If you want to delete all numbers, select Select All from the Edit menu before you select Delete. You 
can also select multiple entries with the control-click and shift-click mouse operations.  

See also: 

Add a number 

Edit a number 

Arrange the numbers 

Import Phone Book Lists 

Export Phone Book Lists 

  

Arrange Numbers  

You can easily arrange the numbers (sort, copy or move).  

Sorting the list:  

Click the different column headings to sort the list.  
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Copying a number from one mobile phone to another:  

1. Click on either the SIM Phonebook or Saved Phonebook icon.  
 

2. Select the number you want to copy.  
 

3. Select Copy to Saved Phonebook or Copy to SIM Phonebook in the Phonebook menu.  
 

Moving a number from one memory to another:  

1. Click on either the SIM Phonebook or Saved Phonebook icon.  
 

2. Select the number you want to move.  
 

3. Select Move to Saved Phonebook or Move to SIM Phonebook in the Phonebook menu.  
 

Note: You can select multiple entries to copy or move with control-click and shift-click mouse operations.  

See also: 

Add a number 

Edit a number 

Delete a number 

Import Phone Book Lists 

Export Phone Book Lists 

  

Import Phone Book Lists  

If you have received a phone book saved as a *.csv file, you can import it into your mobile phone's phone 
book.  

Importing a *.csv file to your mobile phone's phone book:  

1. From the Phonebook menu, select Import...  
 

2. Under the Import options heading, select Merge with existing phone book if you want the new phone 
book to be synchronized into your phone book  
 

3. Select Replace existing phone book if you want to replace the entries in the existing phone book with 
the new phone book.  
 

4. Click  and browse to find the .csv file to import.  
 

5. Click Open and the path and file name are displayed in the Import file name text box.  
 

6. Click Import to complete the import procedure.  
 

See also: 

Add a number 
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Edit a number 

Delete a number 

Arrange the numbers 

Export Phone Book Lists 

  

Export Phone Book Lists  

You can save the entire phone book or parts of it by exporting them to a .csv file.  

Saving phone book entries as a .csv file:  

1. Click on either the SIM Phonebook or Saved Phonebook icon.  
 

2. Select the entry or entries that you want to export (save as a .csv file). 
 

3. From the Phonebook menu, select Export...  
 

4. Select All or Selected Items to export the highlighted entries.  
 

5. Click  and browse to the folder where you want to save the *.csv file, and enter a file name in the 
File name text box.  
 

6. The path and file name is displayed in the Export filename text box. Click Export to complete the 
export procedure.  
 

See also: 

Add a number 

Edit a number 

Delete a number 

Arrange the numbers 

Import Phone Book Lists 
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Messages  

The Messages view enables you to send and receive text messages.  

Note: to send and receive text messages, SMS must be included in your subscription.  

In this view you are able to:  

Create a message.  
 
Edit a message.  
 
Arrange the messages.  
 
Delete a message.  
 
Read a message.  
 
Send a reply.  
 
Forward a message.  
 

Navigating the Text Messages View  

The SMS Messages window is divided into three sections:  

Folders. Click on any folder to display its contents.  
 

SIM SMS. Shows the contents of SMS messages in the SIM. At program startup, all previously 
received SMS messages in the SIM are uploaded to the GC75 Manager program. This is done 
so that the New Messages icon on the Status view can be appropriately displayed. Thereafter, 
new messages are read by responding to new message indications from the card. Messages in 
this folder have a status flag to indicate whether they are read or unread. This is only valid for the 
current program session. The next time the GC75 Manager starts all previous messages will be 
automatically marked as Read in the SIM.  
 
Saved Messages. The contents of this folder are managed by copying or moving messages from 
the SIM folder via appropriate Message View commands.  
 
Sent Items. This folder contains messages that have been successfully sent.  
 
Unsent Items. This folder contains messages that the user has composed but which have not 
been successfully sent. This can occur, for example, if the user composes messages while the 
card is in the Radio Off state, or if the attempt to send the message fails (card responds with an 
error message to send request). Messages in the Unsent Items can be sent at a later time.  
 

Message lists. Displays the contents of the selected folder.  
 
Message detail. Displays the contents of the selected message.  
 

Create a Message  

Creating a message:  
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1. Select Create New Message... from the Messages menu.  
 

2. Enter the destination mobile number in the To: text box or select a number from a Phone Book by 
clicking the Lookup button.  
 

3. Enter your message in the text box.  
 

4. Click the Send button on the dialog.  
 

To successfully send a text message, the GC75 must have the radio transmitter switched on and be in a 
location with network coverage (signal strength).  

Messages are sent as SMS messages. When you enter text in the text box, a counter is displayed in the upper 
right corner. If a SMS message contains more than 160 characters (140 characters for some networks), then 
the SMS will be sent as several messages in chunks of 160 characters. The recipient will see the message as 
one long message and not several smaller messages. Your network operator will charge you for the number of 
messages sent.  

See also: 

Edit a Message 

Arrange the Messages 

Delete a Message 

Read a Message 

Send a Reply 

Forward a Message 

  

Edit a Message  

When you are working with a message, you can edit the text by cutting, copying and pasting or just by 
inserting more text where needed.  

To insert more text, place the cursor where you want to insert more text and enter the desired text.  
 
To Copy text:  

1. Select the text you wish to copy.  
 

2. Select Copy from the Edit menu.  
 

3. Place the cursor where you want to insert the text and select Paste from the Edit menu.  
 

To Move text:  

1. Select the text you wish to move.  
 

2. Select Cut from the Edit menu.  
 

3. Place the cursor where you want to insert the text and select Paste from the Edit menu.  
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See also: 

Create a Message 

Arrange the Messages 

Delete a Message 

Read a Message 

Send a Reply 

Forward a Message 

  

Delete a Message  

Deleting a message:  

1. Select the SIM SMS (Inbox) folder.  
 

2. Select the message you want to delete.  
 

3. From the Edit menu select Delete, or press the Delete button on the computer keyboard.  
 

4. Confirm in the message box that appears.  
 

Note: If you want to delete all messages, select Select All from the Edit menu before you select Delete . You 
can also select multiple messages by using the control-click and shift-click mouse operations.  

See also: 

Create a Message 

Edit a Message 

Arrange the Messages 

Read a Message 

Send a Reply 

Forward a Message 

  

Move or Copy Messages  

To move or copy a message to the Saved Messages folder:  

1. Select the SIM SMS (Inbox) folder.  
 

2. Select the message that you want to save.  
 

3. From the Messages menu or from the right-button context menu select Move to Saved Messages 
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command or Copy to Saved Messages command.  
 

Note: If you want to move or copy all messages, select Select All from the Edit menu or Right-button menu. 
You can also select multiple messages with control-click and shift-click mouse commands.  

  

Arrange the Messages  

To sort the messages, click on the column headings above the message list.  

Send a Reply  

Sending a reply:  

1. Select the folder where the message located.  
 

2. Select the message that you want to reply to. The contents of the message is displayed in the message 
detail area.  
 

3. Select Messages | Reply... . A dialog appears. The receiver is already selected in the To: text box.  
 

4. Enter your reply in the text box.  
 

5. Click the Send button.  
 

Note: For the program to be able to send the message, a GC75 PC Card must be connected. If a mobile 
phone is not connected, Send is disabled (gray).  

See also: 

Create a Message 

Edit a Message 

Arrange the Messages 

Delete a Message 

Read a Message 

Forward a Message 

  

Forward a Message  

Forwarding a message:  

1. Select the folder where the message is located.  
 

2. Select the message that you want to forward. The contents of the message are displayed in the 
message detail area.  
 

3. Select Messages | Forward... and a dialog appears.  
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4. Enter the destination mobile number in the To: text box or select a number from a Phone Book by 
clicking a number from the message list.  
 

5. If you want to add text to the message, enter the new information into the text box.  
 

6. Click the Send button.  
 

Note: For the GC75 Manager to be able to send the message, the GC75 PC Card must be connected. If the 
GC75 PC Card is not connected, the Send button is disabled (gray).  

See also: 

Create a Message 

Edit a Message 

Arrange the Messages 

Delete a Message 

Read a Message 

Send a Reply 

  

Read a Message  

Reading a message:  

1. Click the folder you want to read from.  
 

2. Select the message you want to read. The content of the message is displayed in the message detail 
area.  
 

After reading the message you may:  

Reply to the message.  
 
Forward the message.  
 
Delete the message.  
 

See also: 

Create a Message 

Edit a Message 

Arrange the Messages 

Delete a Message 

Send a Reply 

Forward a Message 
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SIM SMS is Full  

A SIM card is capable of storing a number of messages in the SIM SMS inbox.  

When GC75 Manager detects that the SIM SMS inbox is full, it will display the SIM Full icon on the Status view 
and in the Messages View left pane.  

Note: When SIM SMS storage is full, you must delete some SMS messages from SIM. The mobile network will 
not send any more SMS messages to the GC75 until space is created in the SIM Inbox.  

See also: 

Delete a message 

  

Receiving Cell Broadcast SMS  

The user can optionally enable reception of specific message classes from the SMS Cell Broadcast service. 
Each time a SMS Broadcast message is received, the text of the message will be read from the card and 
displayed in a popup dialog box. When the user clicks OK , the dialog box will close and the message will be 
discarded.  

To enable or disable reception of Cell Broadcast SMS Service, select Settings from the File menu. Click on 
the Text Messages tab. Check or uncheck the Enable check box.  

Note: Use of this feature may require a card firmware update to enable the feature on the card.  

Manage the Service Center Phone Number  

The SMS Service Center number is normally read automatically from the SIM card.  

Changing the Service Center phone number:  

1. Select Service Center Phone Number... from the Messages menu.  
 

2. In the SMS Service Center panel in the phone setting view, enter the Service Center number.  
 

3. Click the Apply button.  
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Connection Wizard  

Welcome to the Connection Wizard! This tool will guide you through the creation of GPRS or CSD/HSCSD 
dial-up connection for your personal computer to connect to the Internet or to a corporate network.  

Note that the option to use GPRS or HSCSD dial-up connection is dependent upon your mobile subscription 
and the availability of the technologies in the mobile network.  

See also: 

Create a GPRS Dial-Up Connection 

Create a CSD/HSCSD Dial-Up Connection 

  

Create a GPRS Dial-Up Connection  

The wizard for creating a GPRS Dial-Up connection simplifies the creation of connection by setting the proper 
values in the Windows Dial-Up Networking entry and linking the entry to one of the GPRS configurations 
present in your GC75 Manager installation.  

The wizard will guide you through the following pages:  

Welcome Page 

Connection Type Page 

Access Point Name Page 

Logon Page 

Finish Page 

  

Create a CSD/HSCSD Dial-Up Connection  

The wizard for creating CSD/HSCSD Dial-Up connection updates the modem settings to ensure the specified 
data rate and type of bearer (ISDN/Analog) will be used when you make a Dial-Up Networking connection  

The wizard will guide you through the following pages:  

Welcome Page 

Connection Type Page 

Dial Phone Number Page 

Logon Page 

Finish Page 
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Welcome Page  

This wizard page will allow you to set the name of the Dial-Up Networking connection.  

1. To create a new connection, select Create a new dial-up connection and insert the name of the new 
dial-up connection that is to be created in the available field. Choose a name that reflects the service 
you intend to connect to and the type of connection, e.g. "My Office via GPRS" or "My Office via 
HSCSD". Indicating the type of connection is useful if you have different connections to the same 
service.  
 

2. If you would like to update an existing entry, select Modify a dial-up connection and then the name of 
the entry to be modified. Open the list box under Modify a dial-up connection by clicking the arrow on 
the right side of the name field. The names of existing dial-up entries in the computer will be displayed.  
 

See also: 

Connection Type Page 

  

Connection Type Page  

This wizard page allows you to choose the type for your dial-up connection:  

1. Select GPRS for choosing the GPRS type of dial-up connection to create.  
 

2. Select CSD/HSCSD for choosing the CSD/HSCSD type of dial-up connection to create.  
 

3. Select the network that you want to connect to. This chooses reasonable defaults for the selected 
network. If the network you want is not displayed, choose Other.  
 

4. Click Next >.  
 

See also: 

Access Point Name Page (for GPRS) 

Dial Phone Number Page (for CSD/HSCSD) 

  

Access Point Name Page  

This wizard page allows you to specify which of the available GPRS configurations should be used by the dial-
up connection.  

Choose the Access Point Name appropriate for your connection. Most networks only have a single access 
point.  

Click on the Add button to add an Access Point Name, if the desired name is not already available in 
the list.  
 
Defaults settings should be sufficient for most networks. If you want to change advanced settings to 
specify IP address, DNS, Minimum QoS, Requested QoS, or IP Header/Data Compression, click on the 
Advanced button to configure.  
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See also: 

Logon Page 

  

Dial Phone Number Page  

This wizard page allows you to set the telephone number to dial when making a dial-up connection.  

1. The Telephone number field is required or the Next> button is disabled.  
 

2. If you want to change setting in Modem speed, Method to obtain IP address, DNS, IP Header/Data 
Compression, click on the Advanced button to configure.  
 

3. Click Next> .  
 

See also: 

Logon Page 

  

Logon Page  

This wizard page allows you to enter your User ID and Password.  

See also: 

Finish Page 

  

Finish Page  

This wizard page indicates that your Dial-Up Networking connection has been created or updated successfully  

Press Back to edit the connection parameters.  
 
Press Finish to exit the wizard  
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Miscellaneous  

This section covers the following topics:  

Troubleshooting  
 
Installing the GC75 Manager  
 
Uninstalling the GC75 Manager  
 

Troubleshooting  

If you are having trouble with your GC75 Card, please check the following:  

1. The SIM card has been properly inserted into the GC75 PC Card.  
 

2. The GC75 PC Card is properly inserted into the computer.  
 

3. The computer's PC Card slot is functioning properly.  
 

4. The GC75 PC Card driver is installed and working properly.  
 

5. The Turn Radio On option for your GC75 PC Card has been selected.  
 

6. Ensure that no other program is using the same COM-port assigned to GC75 PC Card.  
 

Installing the GC75 Manager  

Note: Insert GC75 card before starting the installation.  

To install the GC75 Manager, insert the CD into your computer and choose one of these alternatives  

1. Wait until the installation procedure starts automatically.  
 

2. Start the installation from the Start menu by clicking Run and then entering D:\Start.exe (If D: is your 
CD-ROM drive).  
 

3. Start the installation from the CD by double-clicking the Start.exe file in the root directory.  
 

Once installation has started, follow the instructions on the CD.  

Note: It is strongly recommended that you exit all Windows programs before running the installation program.  

See also: 

Uninstalling the GC75 Manager 

  

Uninstalling the GC75 Manager  

You can easily uninstall the GC75 Manager as follows:  

Page 1 of 2Miscellaneous

4/11/2003file://C:\temp\~hh95A0.htm



1. Close the program before uninstalling.  
 

2. Go to Start | Settings and select Control Panel.  
 

3. Double-click the Add/Remove Programs icon.  
 

4. Select Sony Ericsson GC75 Manager from the list and click Add/Remove.  
 

5. When the computer asks if you want to remove Sony Ericsson Communication Suite and all of its 
components, click Yes.  
 

6. A dialog box informing you of progress appears.  
 

7. When the procedure has successfully been completed, click OK to close the dialog box.  
 

8. To update your computer, click OK. We recommend that you restart your computer afterwards.  
 

See also: 

Installing the GC75 Manager 

  

Glossary  

CSD - Circuit-Switched Data.  

GPRS - General Packet Radio Service. The technology establishes a "always-on" connection but uses it only 
when transferring data.  

GSM - Global System for Mobile Communications.  

HSCSD - High-Speed Circuit-Switched Data. This technology provides higher data transfer rates than 
traditional Circuit-Switched Data connections.  

PIN - Personal Identification Number.  

PUK - PIN Unblocking Key.  

SIM - Subscriber Identity Module.  

SMS - Short Message Service.  
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